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1 Bevezetés 

Jelen dokumentumban általánosan az időben zajló biológiai folyamatok adatelemzéséhez találunk 

gyakorlati alkalmazásokat SAS és IBM SPSS adatelemző szoftverek felhasználásával. A biológiai 

jelek közül most EEG, konkrétan aEEG mért értékekkel dolgozunk, de hasonlóan a kidolgozott 

SAS valamint SPSS kódrészletek aktualizálhatók bármely más jel elemzéséhez. Hiszen, ahogy 

Hajtman Béla írta: a statisztikai módszerek nem tesznek különbséget az adatok közt aszerint, hogy 

honnan származnak, lehetnek orvosi, pszichológiai, műszaki, társadalmi vagy akár gazdasági 

eredetűek is (1). 

A 6.4 fejezetig már az előző negyedéves teljesítés részeként leadott SAS elemzéseket tartalmazza a 

dokumentum. Ennek kiegészítését olvashatjuk a további fejezetekben, elsősorban az idősoros 

elemzés alap módszereit ismerhetjük meg az IBM SPSS szoftver felhasználásával, a kapott 

eredmények értelmezésével. 

2 Kísérlet asphyxiás malacmodellel 

Érett újszülöttekben előfordul szövődményként az aszfixia (légzési elégtelenség), amely lehet 

súlyos maradandó idegrendszeri károsodás, de akár halál okozója is. Előfordulhat enyhébb hatás is, 

de előbbi veszélyek lehetősége miatt érdemes nagy hangsúlyt fektetni a terület vizsgálatára. 

Munkacsoportunk az aszfixia hatásait vizsgálta. 

Az újszülött malac az érett humán újszülött egyik leggyakrabban használt nagy állatmodellje 

(megkülönböztetésül a rágcsálómodellektől) (2, 3). A tudományos kísérlet során újszülött malacok 

aszfixiás állapota során fellépő agykárosodás és az ezt követő regenerálódási folyamatok vizsgálata 

történt. A humán csecsemő születésekor felmerülő cerebrovaszkuláris fiziológiai folyamatokat 

modellezte a munkacsoport. Az eredmények nemrég kerültek publikálásra (4). 

Az aszfixiát a lélegeztetés felfüggesztésével hozták létre. Ilyenkor hipoxia (oxigénhiány) és 

hiperkapnia alakul ki (szén-dioxid felhalmozódik a szervezetben). A szív hipoxiája miatt a 

pumpafunkció károsodik, és 2-3 perc után már a vérellátás jelentős csökkenése, iszkémia (vérellátás 

zavara) is kialakul, főleg azért, mert a keringést fenntartó perfúziós nyomás (artériás – vénás 

vérnyomás) a szívpumpa kialakuló elégtelensége miatt csökken. Az aszfixia szövődményeként 

kialakult kórképet hipoxiás-iszkémiás enkefalopátiának (HIE) is nevezik (az enkefalopátia az agy 

különböző eredetű globális működészavarait jelenti). 

A vizsgálat célja elsősorban azon kérdés megválaszolása volt, hogy egy aszfixiás periódus 

károsítja-e az agyi keringésszabályozásban fontos szerepet játszó mechanizmusokat az aszfixiás 

periódus után 24 órával (azt már jól tudta a munkacsoport, hogy 1 órával később van károsodás, 

ami rendeződni látszik 4 órára (5, 6)). 
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Második kérdés - ami az első kérdés pozitív válasza után merülhetett fel, hogy a hidrogén véd-e a 

károsodás kialakulásától, mert egy korábbi tanulmány szerint az akut károsodás ellen már védett 

(7). 

Újszülött malacokból három csoport került be az egész napos kísérletbe ezek egy kontroll, egy 

aszfixiás és egy hidrogénnel lélegeztetett aszfixiás csoportok voltak. Mindhárom csoportban 9-9 

alany volt, összesen tehát n=27 eset állt rendelkezésre. A kísérlet során legelőször fel lett véve egy 

alap amplitúdó integrált EEG (aEEG) jel kb. 10 percig mindhárom csoportban, majd 8 percen 

keresztüli lélegeztetés elzárással aszfixiás állapot lett előidézve két csoportnál. Ennek 

eredményeképp kb. 1,5 perc után kisimult az aEEG görbe, de az állatok szíve nem állt le. Az így 

előálló hipoxiás-iszkémiás állapotban az egyik csoportot az aszfixiás sokk után 4 órán keresztül 

2,1% hidrogén tartalmú szobalevegővel lélegeztették újra (a reventilláció során adott levegőben a 

szokásos normál 21% oxigén mellett a nitrogénből volt kicsit kevesebb a hidrogén javára). 

Az aszfixia alatti aEEG is rögzítésre került. Az aszfixiás stresszt követően további 22 órán keresztül 

mérte a munkacsoport az aEEG értékeket, óránként kb. 10 percig, 10 Hz-en (vagyis 0,1 

szekundumonként van adatunk, minden óra elején kb. 6000 db). Az adatok az eddigiekben nem 

kvantitatívan lettek elemezve, hanem a felvételek pontozásra kerültek. Az aEEG-n a kérgi 

elektromos aktivitás regenerációját lehet nagyjából nyomon követni, de idősoros elemzés, 

mélyebb összefüggések keresése még nem történt. Jelen dokumentumnak elsősorban ezen 

információk kinyerésének elindítása a célja, különböző módszerek alkalmazásával és 

ismertetésével. 

Emellett egyéb akut mérések is történtek a hipoxiás-iszkémiás folyamatokból történő regeneráció 

állapotának felmérésére. Ezek a rögzített hemodinamikai paraméterek, mint a testhőmérséklet, 

szívfrekvencia, szisztolés vérnyomás vagy szaturáció (SpO2) minden órában, illetve vérgáz (pCO2), 

pH és glükóz négy óránként a két aszfixiás csoport között nem mutatott szignifikáns különbséget 

(kétszempontos ismételt méréses ANOVA, SNK post hoc próba). Emellett EKG jel is rögzítésre 

került. 

A 22 óra után egy kb. kétórás beavatkozással a koponyába egy zárt ablak került implantációra, 

mellyel helyre lehet állítani a koponyaűr zártságát, így nyomásviszonyait. Az agyat burkok veszik 

körül, ezekből a külsőket eltávolították (kemény: dura mater). A harmadik burok szorosan az 

agykéreg felszínéhez tapad (pia mater). Ebben a legbelső agyhártyában ágaznak szét az erek, innen 

fúródnak az agykéreg állományába (parenchyma). Itt a pia materben az agykéreg felszínén futó, 

300 mikrométernél kisebb belső átmérőjű verőerek (pial arterioles, arteriolák: verőerecskék) közül 

egynek nyomon követték az átmérőváltozásait az ablakon át egy operációs mikroszkóp 

segítségével. Ezek az erek már jelentősen befolyásolják az agykérgen átáramló vér mennyiségét, a 

szabályozásban fontos szerepet töltenek be. 

A fontos méréseket a fent említett beavatkozás után, az aszfixiát követő 24-edik órában végezte a 

munkacsoport, amikor is az agyi ér reaktivitását mérték 4 paraméter alapján: hiperkapnia (vér 

magas széndioxid szintje), NMDA, noradrenalin (NA, vagy más néven norepinefrin – NE, egyfajta 
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katekolamin, ami hormonként és neurotranszmitterként is működhet), SNP (sodium-nitroprusside: 

egy értágító – vazodilatátor - hatású só). Hisztopatológiai vizsgálat is történt. 

Az összes mérést a 24 órás túlélés alatt azért végezték, hogy legyen adat arról, hogy az érválaszok 

közötti esetleges különbségeket nem az egy nap túlélés alatti fiziológiai különbségek hozhatják 

létre. Különösen fontos például a testmag hőmérséklete (hipotermia protektív), és a vérnyomás. 

A pial arteriolákon kimutatták, hogy aszfixia után egy nappal is jelentősen megváltozott a 

reaktivitásuk a szén-dioxiddal és az ún. NMDA-val szemben. 

3 Amplitúdó integrált EEG 

Az Elektroencefalográfia (EEG) módszerével az agy elektromos tevékenységét tudjuk időben 

követni (8). A mérőműszerről elvezetett jel, az ún. elektroenkefalogram egy több összetevőből álló 

nemperiodikus görbével írható le. A görbe karakterisztikáját különféle módszerekkel elemzik, mely 

során a háttérben zajló specifikus szenzoros, motoros és kognitív folyamatokat próbálják feltárni, 

jellemezni (9). 

A nyers jel amplitúdójának értelmezési tartománya kb. 100 µV-ig terjed. 

A klasszikus frekvenciatartománya 0,5-30 Hz között mozog (delta, theta, alpha, beta hullámok), de 

felmehet akár 70-80 Hz-re is (gamma hullámok). Ez utóbbiak újszülöttben jellemzően nem 

fordulnak elő, heveny kognitív erőfeszítésnél szoktak ilyen sűrű jelet rögzíteni. 

Az EEG jelből rektifikálást és integrálást követően kapunk amplitúdó integrált EEG (aEEG) jelet. 

4 Szűrés (Filtrálás) 

Nyers jelből (nem feltétlenül EEG, lehet EMG, vagy egyéb mért jel is) a nemkívánatos zaj 

kiszűrése a mérőműszerbe beépített integrált szűrővel történik (10). Különböző szűrők léteznek, 

ilyenek például a következők: 

 Alul áteresztő szűrő (LPF: low-pass filter, high-cut filter): Adott Hz fölötti nemkívánatos 

frekvenciák kiszűrésére alkalmas. Ez szűri ki a váltakozóáramú hálózati zavart. Ez a 

torzulás később nem szűrhető ki. 

 Felül áteresztő szűrő (HPF: high-pass filter, low-cut filter): hogy kiszűrjük a membrán 

potenciálnak köszönhető egyenáram szüneteket, ill., hogy minimalizáljuk az elektródának a 

bőr felszínén való mozgásából következő alacsony frekvenciás interferenciát. Ezzel 

szűrhetjük ki az alapvonal ingadozásait. 

 Sávszűrő (bandpass): Egyben alul és felül áteresztő szűrő is. 

 Sávzáró: Lassan és gyorsan váltakozó zaj jelek kiszűrése 
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 Hálózati zajszűrő: 50 Hz körüli lyukszűrő. 

5 Adatok beolvasása és megjelenítése SAS-sal 

5.1 ADATIMPORT 

Első körben csak egy esethez tartozó adatokat olvassuk be, ez a kísérletből az egyik hidrogénnel 

lélegeztetett aszfixiás malac volt. 

Az adatbeolvasásra és a későbbi adatfeldolgozásra- illetve elemzésre a SAS Enterprise Guide 4.3 

OnDemand alkalmazást használtam, de a SAS Base környezetben is futtatható kódok 

megtalálhatóak jelen dokumentumban. 

A következő kódrészlet egy Excel file-ból az adatbeolvasásra előkészített szerkezetű 

munkalapjának adatimportját végzi el. Ez az adatelőkészítés annyit jelent, hogy az adatok úgy 

kerültek strukturálásra, hogy az Excel munkalap - melynek neve „ForSAS” (lásd a kódban) - első 

sorában az ékezettől, szóköztől és mindenféle speciális karaktertől mentes érthető (beszédes, de 

rövid, használható) változónevek szerepelnek, az alatta lévő sorokban pedig az egyes 

időpillanatokban (tizedmásodperc) mért értékek szerepelnek. Amennyiben hiányzó érték van, annak 

helyét üres cella jelzi. 

/* Jelfeldolgozás (aEEG alapon) - Signal processing */ 

PROC IMPORT OUT= PHD.EEG_m767_1_AH2 

 DATAFILE= 

 "f:\Data\phd\osztondij\Apaczai_2012_nov\teljesites\ 

 1.nev\munka\malac_EEG\m767_1_AH2.xls" 

 DBMS=EXCEL 

 REPLACE; 

RANGE="ForSAS$"; 

 GETNAMES=YES; 

 MIXED=NO; 

 SCANTEXT=YES; 

USEDATE=YES; 

SCANTIME=YES; 

RUN; 

 

 

SAS Enterprise Guide OnDemand alkalmazásban a File menü Import data almenüjében megjelenő 

varázslóval végig is kattinthatjuk az adatimport paraméterezését. Az adatbeolvasás eredményét az 

Enterprise Guide Process Flow munkaterületén az alábbi node-ok (csomópont) jelzik. 
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Közvetlenül az adatimport után rögtön megnyitja a program az adatállományt, mely a későbbiekben 

is megtekinthető a Data Imported csomópontra kattintva. 

 

5.2 MÉRT ADATOK GRAFIKUS MEGJELENÍTÉSE AZ IDŐ FÜGGVÉNYÉBEN 

A Process Flow-n egy Program node-ba (jobb egérgombbal felvehetünk egy új programot a New → 

Program funkcióval) beírhatóak az alábbi kódrészletek, melyekkel a SAS GRAPH felhasználásával 

megjeleníthetjük az egyes mért értékeket időben. Az egész kódsort egy GOPTIONS keretbe 

célszerű foglalni, hogy a korábbi és későbbi grafikus beállításoktól elkülönüljön. 

Azt, hogy melyik mért értéket (jelet) szeretnénk ábrázolni az idő függvényében, a PROC GPLOT 

eljárás PLOT utasításában adjuk meg. Jelen példában az alapjelet tüntetjük föl („alap” a változó 

neve is, ez az a kb. 10 percig mért jel, amit az aszfixiás sokk előidézése előtt mértek). A következő 

néhány hasonló kódrészletben látható, hogy ez a változó van egyrészt kicserélve az aktuális mért jel 

változójára (asph, h1, h2). Az aktuális mért jeltől függ, hogy a diagram címének mit adunk. Ezt a 

PROC GPLOT előtt a TITLE sorában az idézőjelek között módosíthatjuk az adott tartalom szerint. 

Ha a mérések száma meghaladja a jelen példa szerint kirajzolt 7000 db-ot, akkor az AXIS1 

tengelybeállításoknál az ORDER opcióban hasonló 1000-es lépésköznél az 1000 adott számú 

többszörösére módosítsuk a vízszintes tengelyen látható érték intervallumot (idő), hogy minden 

mért adat látszódjon. Ha egyéb formai beállításokon (pl. betűtípusok, méretek, színek, stb.) nem 

szeretnénk változtatni, akkor ennyi elegendő hasonló frekvencián mért aEEG jel esetén 

(módosítandók tehát a szürkével jelölt részek). A fent látott adatállomány többi változójára ennek 

mintájára készíthetjük el az ábrázolást. 
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Más jel és más frekvencia esetén a tengelyek feliratait (AXIS LABEL) is módosítanunk kell, illetve 

természetesen magát az adatállományt (PROC GPLOT DATA opciójában) (11). 

/* mért amplitúdó integrált EEG (aEEG) értékek szemléltetése */ 

goptions reset=all border ctext=black ftext="Arial" htext=10 pt; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

 value=(rotate=0 angle=0) order=(0 to 7000 by 1000) 

axis2 minor=none label=(angle=90 "aEEG"); 

symbol1 line=1 ci=black cv=black value=Dot interpol=join width=1 height=1 pt; 

title height=14pt 'Alap amplitúdó integrált EEG értékek'; 

proc gplot data=m767_1_ah2; 

plot alap*time 

/ haxis=axis1 

 vaxis=axis2 

 cframe=white 

 caxis=black; 

run; quit; 

goptions reset=all; 

 

 

A következő három kódrészlet az előző mintájára készült, az aszfixiás, az első és a második órában 

mért aEEG adatokat szemlélteti vonaldiagramon. A módosítások itt is szürkítve vannak. Eszerint a 

többi órában mért jeleket is lehet ábrázolni. 

goptions reset=all border ctext=black ftext="Arial" htext=10 pt; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

 value=(rotate=0 angle=0) order=(0 to 12000 by 1000) 

axis2 minor=none label=(angle=90 "aEEG"); 

symbol1 line=1 ci=black cv=black value=Dot interpol=join width=1 height=1 pt; 

title height=14pt 'Asphixiás amplitúdó integrált EEG értékek'; 

proc gplot data=m767_1_ah2; 

plot asph*time 

/ haxis=axis1 

 vaxis=axis2 

 cframe=white 

 caxis=black; 

run; quit; 

goptions reset=all; 

 

 

goptions reset=all border ctext=black ftext="Arial" htext=10 pt; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

 value=(rotate=0 angle=0) order=(0 to 8000 by 1000) 

axis2 minor=none label=(angle=90 "aEEG"); 

symbol1 line=1 ci=black cv=black value=Dot interpol=join width=1 height=1 pt; 

title height=14pt 'Amplitúdó integrált EEG értékek az első órában'; 

proc gplot data=m767_1_ah2; 

plot h1*time 

/ haxis=axis1 

 vaxis=axis2 

 cframe=white 

 caxis=black; 

run; quit; 

goptions reset=all; 
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goptions reset=all border ctext=black ftext="Arial" htext=10 pt; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

 value=(rotate=0 angle=0) order=(0 to 7000 by 1000) 

axis2 minor=none label=(angle=90 "aEEG"); 

symbol1 line=1 ci=black cv=black value=Dot interpol=join width=1 height=1 pt; 

title height=14pt 'Amplitúdó integrált EEG értékek a második órában'; 

proc gplot data=m767_1_ah2; 

plot h2*time 

/ haxis=axis1 

 vaxis=axis2 

 cframe=white 

 caxis=black; 

run; quit; 

goptions reset=all; 

 

A következő ábrák az előző négy SAS kód lefuttatásával készültek. 

Alap amplitúdó integrált EEG értékek  
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Asphixiás amplitúdó integrált EEG értékek  
 

 
 

 

 

 

Amplitúdó integrált EEG értékek az első órában  
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Amplitúdó integrált EEG értékek a második órában  
 

 
 

 

 

6 Idő alapú jelfeldolgozás SAS szoftver felhasználásával 

6.1 ARTEFAKTUMOK KISZŰRÉSE 

A láthatóan nagyon kiugró értékek a jelben csak artefaktumok. 

Az ilyen zajos adatok kiszűrését a következő rövid kódrészlettel tudjuk megtenni SAS-ban 

ugyancsak egy Program node-ban, mely során az, hogy a szűrési algoritmusban milyen szorzót 

alkalmazunk, az egyszerűen állítható (jelen példában 8-as szorzót használunk a második DATA 

step-ben – szürkével jelölve). Az artefaktum nélküli értékeket a második DATA step-ben létrejött 

ideiglenes alap_no_artefact nevű adatállományban az alap2 nevű változóban tároljuk. 

/* http://scott.sherrillmix.com/blog/programmer/sas-macros/  alapján */ 

proc means data=work.m767_1_ah2 mean; 

 var alap; 

 output out=mean mean=alap_mean; 

run; 

/* mean(alap)=9.39 */ 

 

data mean; 
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 set mean; 

 call symput('alapmean',trim(left(alap_mean))); 

run; 

data alap_no_artefact; 

 set work.m767_1_ah2; 

 if alap > &alapmean *8 then alap2=&alapmean; else alap2=alap; 

run; 

 

 

A következő kódrészlet a már az adatok megjelenítésénél látott GPLOT eljárás alkalmazása az alap 

mért jelre. Két görbét is megjelenítünk, hogy látszódjon, a szűrés működött. Az eredeti alap nevű 

változót kékkel rajzoljuk ki (SYMBOL1 formája szerint), míg erre rakjuk a szűrt alap2 változót 

pirossal (SYMBOL2). A PROC GPLOT-ban a symbol1 és symbol2 utasítások aktiválása a PLOT-

ban a per jel előtti számokkal történik (zölddel színezve a háttere a kódban az alap2 beállításának). 

goptions reset=all; 

symbol1 interpol=join color=blue; 

symbol2 interpol=join color=red; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

value=(rotate=0 angle=0) order=(0 to 7000 by 1000); 

axis2 minor=none label=(angle=90 "aEEG"); 

Title 'Eredeti és artefaktum nélküli alap aEEG'; 

proc gplot data=alap_no_artefact; 

plot alap*time=1 alap2*time=2 

/ overlay 

 haxis=axis1 

 vaxis=axis2; 

run; quit; 

goptions reset=all; 

 

Az eredmény egyrészt a számított átlagértéket mutatja, valamint az átlagtól vett 8-szoros 

különbséggel számolva a kiugró értéket, azokat kiszűrve szemlélteti vonaldiagramon. 

The MEANS Procedure 
 

Analysis Variable 
: alap  

Mean 

9.3905537 
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Eredeti és artefaktum nélküli alap aEEG  
 

 
 

 

 

 

 

 

 

Csak az artefaktum nélküli görbe és SAS kódja: 

goptions reset=all; 

symbol1 interpol=join color=red; 

axis1 minor=none label=("Time (0.1 sec)") offset=(5, 5) 

 value=(rotate=0 angle=0) order=(0 to 7000 by 1000); 

axis2 minor=none label=(angle=90 "aEEG"); 

title 'Artefaktum nélküli alap aEEG'; 

proc gplot data=alap_no_artefact; 

 plot alap2*time=1 / haxis=axis1 vaxis=axis2; 

run; quit; 

goptions reset=all; 



TÁMOP 4.2.4.A/2-11-1-2012-0001  László Anna 

72 / 14 
 

Artefaktum nélküli alap aEEG  
 

 
 

 

6.2 EGYENIRÁNYÍTÁS (REKTIFIKÁLÁS) 

Egyenirányításra akkor van szükség, ha negatív mért értékeink is lennének. Jelen esetben amplitúdó 

integrált EEG értékeink vannak, melyekből első lépésben már abszolút érték lett képezve, vagyis 

megtörtént az egyenirányítás, nincs rá külön szükség. 

 

Ha más jelünk lenne, ahol van értelme rektifikálni, akkor annak a SAS kódja az alábbi lenne. 

Általános kódot láthatunk, ahol a kiinduló adatállomány adat névre hallgat, és ebből egy adat_ret 

nevű adatállományt hozunk létre, melyben mondjuk a h22 változó jelét rektifikáljuk egy új, r 

elnevezésű változóba. Az eddigiek alapján ezt is megjeleníthetjük szemléltetés végett egy GPLOT 

eljárással. 

/*  Rektifikálás: egyenirányítás  */ 

data adat_rekt; 

 set adat; 

 if h22<0  

 then r=0+(0-h22); 

 else r=h22; 
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run; 

 

Megjegyzés: az egyenirányítás tulajdonképpen egy abszolút érték műveletet jelent matematikailag, 

ami igencsak adatvesztéssel jár, az adatok szóródása is megváltozik ezzel. Radikális változást 

eredményez, amit jó szem előtt tartani. Természetesen lehetnek olyan esetek, amikor nincs értelme 

az irányultságot értékelni csak az amplitúdó nagysága számít, ekkor alkalmazható. 

6.3 NORMALIZÁLÁS 

Normalizálást követően lesznek a mérések összehasonlíthatóak. Egy adott értékhez (maximum, 

átlag, tetszőleges) viszonyítunk. 

Például a maximum értékhez viszonyítva (ezzel osztva) a 0-1 skálára hozzuk az értékeinket az 

alábbi SAS kód segítségével: 

/*  Normalizálás: 

 maximum értékkel való osztás - rektifikált adatokon. */ 

proc means data=adat_rekt max; 

 var r; 

run; 

data adat_rekt_norm; 

 set adat_rekt; 

 normalt = r / 42;      /* a max érték 42 */ 

run; 

6.4 ÁTLAGOLÁSOK 

A váltakozójelek jellemzésére gyakran használjuk középértékeiket. Ezek a középértékek 

átlagértékek. Ezek egyszerű integrálások (adott időegységenként vagy meghatározott 

feszültséghatárig), illetve középérték számítások (10). 

A következőben egy a saját adatainkra aktualizált SAS macro-t olvashatunk, mely elvégzi az 

integrálszámítást (12). 

Ha az előző egyenirányítás és normalizálás lépéseket a 22-edik órában mért első 100 jel adatán 

végezzük el, és ezen adatok a h22_100_rekt_norm nevű adatállományban vannak eltárolva a 

normalt nevű változóban, akkor a következő kódot lefuttatva tudunk integrált számolni ezen 

görbéhez. 

*http://www.lexjansen.com/wuss/2004/posters/c_post_the_sas_calculations_.pdf 

* The following two SQL procedures are optional code blocks, choosing one of 

them to compute the baseline value from some early observations of the data file 

and store it as a macro variable, BaseY; 

* Baseline value is taken as the mean of all observed values prior to the time 

zero.; 

PROC  SQL; 

SELECT MEAN(normalt) FORMAT=6.2 LABEL='Avg normalt' INTO : BaseY 
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FROM h22_100_rekt_norm  

WHERE time LT 0 ; 

QUIT 

; 

* Baseline value is taken as the mean of the first 3 observed values.; 

PROC SQL INOBS=3 ; 

SELECT MEAN(normalt) FORMAT=6.2 LABEL='Avg normalt' INTO : BaseY 

FROM h22_100_rekt_norm; 

QUIT; 

 

* This is the macro that calculates the 3 AUCs.; 

%MACRO AUC(baseline, dataset, output); 

DATA &output; 

SET &dataset (WHERE=(time GE 0)); 

RETAIN Basevalue; 

IF &baseline = 0 THEN Basevalue = 0.0; 

*&BaseY shown in the following statement is the macro variable defined in any 

one of the above SQL procedures; 

IF (&baseline = 1 OR &baseline = 2) AND _N_ = 1 THEN Basevalue = &BaseY; 

normalt = normalt - Basevalue; 

DROP LagTime LagValue; 

LagTime = LAG(time); 

LagValue = LAG(normalt); 

IF time =0 

THEN DO; 

  LagTime =0; 

  LagValue =0; 

END;   

IF &baseline = 2 AND normalt > 0 AND normalt <= 0.0 

THEN DO; 

  * Connecting line with positive slope, only the area of right triangle (above 

baseline) is counted.; 

  DROP Ratio; 

  Ratio = normalt / (ABS(LagValue)+normalt); 

  Trapezoid = Ratio*(time-LagTime)*(normalt+0.00)/2; 

END; 

ELSE IF &baseline = 2 AND normalt < 0 AND LagValue >= 0.0 

THEN DO; 

  * Connecting line with negative slope, only the area of left triangle (above 

baseline) is counted.; 

  DROP Ratio; 

  Ratio = LagValue / (LagValue+ABS(normalt)); 

  Trapezoid = Ratio*(time-LagTime)*(0.00+LagValue)/2; 

END; 

ELSE IF &baseline = 2 AND normalt < 0 AND LagValue < 0 THEN Trapezoid = 0.0; 

* Negative trapezoidal area is not counted.; 

ELSE Trapezoid = (time-LagTime)*(normalt+LagValue)/2 ; 

* The rest of all positive trapezoidal areas are counted.; 

SumTrapezoid + Trapezoid; 

FORMAT Trapezoid SumTrapezoid 8.3 ; 

RUN; 

%MEND AUC;  

 

 

A SAS Macro meghívása és kiíratása 

%AUC(0, h22_100_rekt_norm, integral); 

 

proc print data=integral; 
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 var time normalt sumtrapezoid; 

run; 

A futtatás eredménye a következő lett: 

Obs time normalt SumTrapezoid 

1 1 0.38095 0.000 

2 2 0.32952 0.355 

3 3 0.61905 0.830 

4 4 0.49619 1.387 

5 5 0.56762 1.919 

6 6 0.56762 2.487 

7 7 0.44857 2.995 

8 8 0.49619 3.467 

9 9 0.64286 4.037 

10 10 0.33333 4.525 

11 11 0.47238 4.928 

12 12 0.42857 5.378 

13 13 0.47238 5.829 

14 14 0.35714 6.243 

15 15 0.50000 6.672 

16 16 0.44857 7.146 

17 17 0.59143 7.666 

18 18 0.54381 8.234 

19 19 0.47238 8.742 

20 20 0.47238 9.214 

21 21 0.54762 9.724 

22 22 0.80952 10.403 

23 23 0.50000 11.058 

24 24 0.35714 11.486 

25 25 0.61905 11.974 

26 26 0.40476 12.486 

27 27 0.47238 12.925 

28 28 0.42857 13.375 

29 29 0.66667 13.923 

30 30 0.83333 14.673 

31 31 0.42476 15.302 

32 32 0.52381 15.776 

33 33 0.45238 16.264 

34 34 0.32952 16.655 

35 35 0.78571 17.213 

36 36 0.33333 17.772 

37 37 0.37714 18.128 

38 38 0.47238 18.552 

39 39 0.47238 19.025 

40 40 0.40095 19.461 

41 41 0.49619 19.910 

42 42 0.37714 20.347 
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43 43 0.45238 20.761 

44 44 0.59524 21.285 

45 45 0.49619 21.831 

46 46 0.49619 22.327 

47 47 0.56762 22.859 

48 48 0.52000 23.403 

49 49 0.47238 23.899 

50 50 0.59524 24.433 

51 51 0.45238 24.957 

52 52 0.35714 25.361 

53 53 0.47238 25.776 

54 54 0.52000 26.272 

55 55 0.52000 26.792 

56 56 0.47238 27.289 

57 57 0.52000 27.785 

58 58 0.52000 28.305 

59 59 0.54381 28.837 

60 60 0.49619 29.357 

61 61 0.35333 29.781 

62 62 0.52381 30.220 

63 63 0.45238 30.708 

64 64 0.52381 31.196 

65 65 0.32952 31.623 

66 66 0.45238 32.014 

67 67 0.52381 32.502 

68 68 0.35714 32.942 

69 69 0.54762 33.395 

70 70 0.32952 33.833 

71 71 0.38095 34.189 

72 72 0.40095 34.580 

73 73 0.49619 35.028 

74 74 0.49619 35.524 

75 75 0.47238 36.009 

76 76 0.38095 36.435 

77 77 0.42476 36.838 

78 78 0.40095 37.251 

79 79 0.49619 37.700 

80 80 0.35333 38.124 

81 81 0.56762 38.585 

82 82 0.50000 39.119 

83 83 0.38095 39.559 

84 84 0.61905 40.059 

85 85 1.00000 40.869 

86 86 0.50000 41.619 

87 87 0.33333 42.035 

88 88 0.47238 42.438 

89 89 0.42857 42.889 
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90 90 0.45238 43.329 

91 91 0.47238 43.791 

92 92 0.56762 44.311 

93 93 0.56762 44.879 

94 94 0.45238 45.389 

95 95 0.61905 45.925 

96 96 0.52000 46.494 

97 97 0.32952 46.919 

98 98 0.44857 47.308 

99 99 0.44857 47.757 

100 100 0.47238 48.217 

 

A teljes görbe alatti terület ebben az esetben 48,217 lett. 

 

Megjegyzés: A görbe alatti terület (AUC: Area Under Curve) egyetlen mérőszámmal jellemzi az 

adott időtartamban vizsgált adatsort. Ez nem írja le a görbe karakterisztikáját. Igen sokféle lefutású 

görbének lehet ugyanaz az AUC értéke, pedig már ránézésre is jól látható eltérések mutatkoznak. 

Lehet, hogy már az időintervallum elején magasabb mért értékeink vannak, és ezt követően ez 

lecseng, vagy pont fordítva, monoton, vagy valamilyen ingadozással, de növekvő trendet mutat. Ezt 

érdemes szem előtt tartani. 

Ez hasonló, mint a modellek összehasonlítására is használatos ROC görbe – Receiving Operating 

Characteristics -, melynél lehet az AUC értéke ugyanaz pl. 3 modell szenzitivitásának és 

specifikusságának összevetésekor, mégsem mindegy, hogy melyik görbe milyen sebességgel 

változik (jellemzően, amelyik inkább közelít a (0,1) ponthoz, az a modell valamivel jobban 

magyarázza az adatainkat). 

7 Idősoros elemzés IBM SPSS Statistics felhasználásával 

Az alábbi fejezetben az előzőekben SAS-ban mutatott adatfeldolgozást és elemzést SPSS-ben 

folytatjuk. Az adatbeolvasást, megjelenítést és az artefaktumok kiszűrését természetesen itt is 

elvégezzük, ezzel összehasonlítva a két szoftverben működő módszerek alkalmazását ezen 

műveletekre. 

A különféle módszerek gyakorlati alkalmazásának szemléltetésére a korábbiakban is használt malac 

(a kísérletből az egyik hidrogénnel lélegeztetett aszfixiás malac) alap aEEG adatsorát mutatjuk be. 

Az idősoros elemzéseket az IBM SPSS Statistics Version 21 szoftverrel végezzük, melyben 

többnyire a FORECASTING modult futtatjuk. Az analízisek elvégzéséhez elméleti és gyakorlati 

útmutatót vettünk alapul (13), melyben a 2.10-es fejezetet használtuk fel. 

Azt fontos tudnunk, hogy az ilyen sűrű jel feldolgozásában nem feltétlen célravezető az adatok 

időben történő vizsgálata, ezekkel érdemes viszont kezdeni, majd áttérni különféle spektrális 
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módszerekkel történő megközelítésekre, de jelen dokumentummal elsősorban az a célom, hogy 

gyakorlati példákkal szemléltessem az adatelemzési módszerek alkalmazását és értelmezését. A 

Ketskeméty – Izsó – Könyves Tóth féle könyvben az idősorok elemzéséhez jobban használható 

napi, heti, havi, negyedéves vagy éves példa adatok állnak rendelkezésre, melyek szabadon 

elérhetőek. Ilyenek például nyomtatók napi energia-felvételét tartalmazó idősor, részvények 

jegyzéseinek alakulása, Magyarország népességi adatai egy év havi idősorával, Magyarország 

villamos energia termelése 1975 és 1994 között vagy például vasúti áruszállítás alakulását mutató 

negyedéves idősor. Ezekben a cél leginkább valamilyen trend valamint szezonalitás keresése, és a 

legjobban illeszkedő modell alapján előrejelzés elvégzése. Általános közelítő szabály, hogy egy 

idősor elemzéséhez minimálisan 50, de inkább néhány száz adatra van szükség (13). 

7.1 ADATOK BEOLVASÁSA 

Az adatokat ugyancsak a már korábban Excelben előkészített „forSAS” munkalapról olvassuk be, 

mely az alábbiképpen néz ki MS Excelben: 

 

Jellemzően minden statisztikai, adatelemző szoftver inputjaként hasonló elrendezésre kell az 

adatokat hozni: a sorokban az egyes megfigyelések, az oszlopokban pedig a változók. 
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Az első sorba be lehet a változó neveket írni, az adatimport során ezeket jellemzően változó 

nevekké lehet konvertálni a szoftverekben. A lényeg az, hogy ne használjunk speciális karaktereket, 

ékezeteket és szóközöket a változók elnevezésekor, mégis beszédesek legyenek a használt nevek. 

Ezután címkékkel elláthatók minden szoftverben a változók, ahol már fel lehet ékezetes betűket és 

egyéb karaktereket is használni. 

Az adatimporthoz SPSS-ben a következő szintaxist futtathatjuk le, vagy kattintással is 

beolvashatjuk az adatokat a File → Read Text Data… menüponttal. 

 

Az SPSS-ben nyitható külön Syntax ablak (File → Open → Syntax…, ahol az adott kódrészlet 

kijelölésével az ikonsoron a nagy zöld háromszöggel (Run Selection) lehet a futtatást elvégezni. Itt a 

Syntax ablakban a fenti képen látható módon színezi a kódot a program, hogy könnyebben lehessen 

értelmezni. 

Az importálandó file típusát a TYPE opcióban adhatjuk meg, jelen esetben ez XLS. Az adatokat 

tartalmazó file fizikai elérési útját a FILE opcióban definiálhatjuk. Azt, hogy a megadott XLS 

kiterjesztésű file melyik munkalapja tartalmazza az adatállományt, melyet be szeretnénk olvasni, a 

SHEET opcióban adjuk meg. Mindez a GET DATA utasítás paramétereit képezi. A SAVE 

utasítással az OUTFILE-ban megadott fizikai elérési útra s név szerint elmenthetjük az SPSS 

adatállományunkat. Ez jelen esetben SAV kiterjesztést jelent. 

A futtatással a következő kép szerint rendben beolvasásra kerültek az adatok az IBM SPSS 

rendszerbe. 
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Ellenőrizzük, hogy minden változót érték jellegű adatként ismert-e föl az SPSS. A Variable View 

munkalapon minden változó (itt sorokban találjuk) legyen skálaváltozó, vagyis a Measure 

oszlopban legyen Scale beállítva a következő kép szerint. 
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7.2 ADATOK SZŰRÉSE 

Ahogy azt a fejezet elején kifejtettük, idősoros elemzésben jellemzően legalább 50, de inkább 

néhány 100 adat szükséges az adatelemzéshez. A mért aEEG jel nekünk nagyobb frekvencián mért, 

az alap jelből kb. 6000 adatunk van. A módszerek és azok értelmezésének ismertetése és könnyebb 

áttekinthetőség végett csak másodperc alapon tartjuk meg az adatokat. Ezért kiszűrjük minden 

tízedik adatot, hiszen tized másodpercenként van mért jelünk az adatállományban. Ehhez a 

következő kódsort futtathatjuk le, mellyel egyúttal a kiszelektált adatokat új adatállományba is 

mentjük, és az előzőt be is zárhatjuk. 
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Mivel kb. minden óra első 10 percében történt a jel detektálása és mentése, de ez nem pontosan 

6000 adatot jelent, most levágjuk a 10 perc fölötti esetleges adatokat, a módszerek futtatása és 

értelmezése szempontjából nem számítanak. Ezt a fenti szintaxisból a következő sor végzi: 

SELECT IF (MOD(time,10)=0 and time<=6000). 

A Data View nézetben az SPSS-ben a következő kép szerint sikeresen leválogattuk az adatainkat. 

 

Jól látható, hogy mind a 25 változóban (oszlopok) 600 másodpercre van adatunk (sorok), mindössze 

két órában történt a jel regisztrálása rövidebb, mint 10 percig (h8 és h18 – ezekben hiányzó 

értékeket látunk az utolsó sorokban, de ennyi adat mellett a 4-5 hiányzó érték elenyésző). 

A Variable View nézetben most is leellenőrizhetjük, hogy minden változó maradjon meg mérési 

skálán értelmezettnek, de itt már, mivel előzőleg a teljes adatállományon beállítottuk, nincs rá 

szükség külön. 
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A fenti adatszűrés természetesen menüből is vezérelhető kattintással, ehhez a Data menüben a 

Select Cases… menüpontot kell választani. 

7.3 MEGJELENÍTÉS 

Az alap jel másodperces adatainak megjelenítéséért a következő programkód felel. 

 

Ezt amúgy az Analyze → Forecasting → Sequence Charts… menüponttal is beállíthatjuk. 

A TSPLOT utasításban a VARIABLES paraméterben adhatjuk meg a kirajzolandó idősorokat. 

Most csak egyet, az alap jelet adtuk meg, így azt teszi a függőleges tengelyre a vízszintes ID 

opcióban megadott time szerint. 

A futtatás eredményeként az Output ablakban megkaptuk a következő grafikont. 

 
Jól látható, hogy a 141-edik másodperc környékén van egy kiugró érték (ahogy azt már korábban a 

SAS szoftverrel is kimutattuk). Ez artefaktumnak minősül, amit ki kell szűrni a jelből. A következő 

lépésben ezt tesszük meg. 
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7.4 ARTEFAKTUMOK KISZŰRÉSE 

SPSS-ben lehetőségünk van anomáliák automatikus detektálására. Erre szolgál a következő 

kódrészlet, mellyel 3 csoportot képez a szoftver az alap jel értékei alapján, és lementi 1-es, 2-es és 

3-as értékekkel egy új, Peer_alapId nevű változóba (ez elérhető a Data → Identify Unusual 

Cases… menüponttal is). 

 

A fenti szintaxis futtatásával (a SAVE hatására) létrejön az új változó. Láthatjuk az 

adatállományban, hogy a nagy kiugró értékünk a 141-edik sorban található, ahogy azt előzőleg a 

szekvencia diagramon detektáltuk. 

 

Kérjünk le alapstatisztikát az új csoport változóról, hogy egy kicsit megismerjük. 
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A kapott eredményben leolvashatjuk a Case Processing Summary táblából, hogy a 3 csoportban 

hogyan oszlanak el az adatok. Az 1-esbe 341 másodperc adatát sorolta a rendszer, a 2-esbe 247 db-

ot, míg a 3-asba mindössze 12-t. A fenti Data View-ban is látható, hogy a 141-edik másodperc 

nagyon kiugró 492-es értékét a 3-as csoportba sorolja. Ezt a Descriptives táblából is kiolvashatjuk 

az eredmények közül. Az 1-es csoport 7-27 közötti aEEG alap adatokat tartalmaz, a 2-es a 0-6 

intervallumból származóakat, míg a 3-as 29 és 492 közöttieket. 

Az átlag standard hibája az első két csoportban 0,5 alatti, vagyis kicsit szóródnak az adatok az átlag 

körül, míg a 3-as csoportban 38,132, jelezve, hogy itt elég nagy a variancia. 

A boxplotról is látható, hogy a 3-as csoportban egy igazán kiugró érték van, a korábban már észlelt 

492-es 141 másodpercnél. 

 
Ezért csak a 3-as csoportba tartozó értékeket szűrjük ki az alábbi algoritmus szerint. 
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Az ábrák alapján láthattuk, hogy a kiugró értékek melletti környező adatok már nem lógnak ki 

számottevően, így az adott, 3-as csoportba tartozó értékek esetén, az őket 5 másodperccel megelőző 

értékkel helyettesítjük a kiugró értékeket. Megtehetnénk azt is, hogy látva a görbét, csak a 141-es 

sor adatát cseréljük le, de egyöntetűen is végezhetünk helyettesítést, hisz a többi adatba ez nem 

nagyon zavar be, lévén a környező adatok eléggé hasonló amplitúdóval bírnak. Az artefaktum 

nélküli amplitúdó értékeket egy új, alap_c elnevezésű változóba mentjük, ami természetesen a 

legtöbb esetben (1-es és 2-es csoportok a Peer_alapId szerint) az alap jellel egyenlő. 

Ezeknél a másodperces adatoknál a malac aEEG jelében nem várunk időbeli eltolódást 

különösképp, azért megnézzük mit mutat az elemzés (alátámasztja-e ezt a megérzésünk). 

A fenti szintaxis szerint már meg is jelenítettük a TSPLOT utasítással az eredményt. 

Az első diagram az eredeti (kék görbe) és az artefaktum kiszűrésével keletkezett idősort (zöld 

görbe) is tartalmazza, míg a második már csak a javított tartományra koncentrál. 

 
Láthatjuk, hogy a nagy zaj kiszűrése megtörtént az alap jelből alap_c változóba mentve. 
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Az így kapott szűrt és zajmentes jellel, mint idősorral dolgozunk tovább. 

Természetesen ilyen esetben célszerű a szakemberrel egyeztetni, aki a kísérletet tervezte és/vagy 

végezte, felhasználja az eredményeit, hogy milyen szinten számít artefaktumnak egy-egy adat, és a 

tisztított idősor már tekinthető-e artefaktumoktól mentes, további elemzésre alkalmas 

regisztrátumnak. 

7.5 NORMALITÁS ELLENŐRZÉS 

Érdemes ellenőrizni, hogy az előzőleg korrigált alap jel (alap_c változó értékei) normális eloszlást 

követ-e, hogy megnézzük, lehet-e benne valamiféle trend, vagy egymástól független adatokról van 

szó. A következő lépésben tehát megvizsgáljuk, hogy egyáltalán lehet-e az alap_c idősorában trend, 

vagy ez az idősor időben nem változik. Ehhez azt kell megnéznünk, hogy normális eloszlást követ-

e. Ha igen, akkor nem érzékelhető benne időbeni tendencia. 

A következő szintaxis lefuttatásával egy P-P diagramot rajzolhatunk ki. 
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A futtatás eredménye az alábbi diagram. 

 
Látható, hogy a pontok nem igazán illeszkednek az átló egyenesére, hanem attól eltérően, egy 

másik függvény vonulatát követik. Van tehát valamiféle szabályosság az adatsorunkban. Eszerint az 

a sejtésünk, hogy nem követ normális eloszlást az adatsor. 

De nézzük meg egy hisztogramon is az eloszlás alakulását a következő kódrészlet segítségével. 

 

Az eredményt az Output ablakban találjuk. 
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A hisztogramon is látható a normális eloszlás haranggörbéjétől való eltérés: jobbra ferde eloszlást 

követnek az értékeink. 

Egy statisztikai próbával is alátámaszthatjuk valamelyest a megérzésünket. Futtassunk egy 

Kolmogorov-Smirnov próbát a normális eloszlástól való eltérés tesztelésére a következő 

programkód alapján. 

 

A kapott p-érték 0,000 (természetesen nem pontosan 0, csak 3 tizedes jegy pontossággal adja meg a 

program alapértelmezetten); ami azt jelenti, hogy szignifikánsan eltérünk attól a nullhipotézistől, 

miszerint normális eloszlást követnek az adataink, vagyis nem normális eloszlású populációból 

származik ez az idősor. 

Azt azért szem előtt kell tartani, hogy ez a próba alapvetően független adatokat feltételez, és a mi 

esetünkben az idő, mint kovariáns mindig jelen van, eszerint összetartozóak az adataink. De a 

grafikonok alapján mondhatjuk, hogy van értelme idősoros elemzést végezni az adatokon. 
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7.6 AUTOKORRELÁCIÓ 

Egy idősorban az adatok időbeli összefüggését autokorrelációval lehet vizsgálni. Az autokorrelációs 

és parciális autokorrelációs függvények (ACF: AutoCorrelation Function, PACF: Partial 

AutoCorrelation Function) értékeivel lehet felmérni, hogy az idősor adott elemére milyen 

mélységben van hatással a múltja, azaz a korábbi időpontbeli változók közül mennyi van 

szignifikáns korrelációban vele (13). 

Ezek az értékek is, mint a korrelációs koefficiens -1 és 1 közötti értékek lehetnek. A 0-hoz közeliek 

a lineáris kapcsolat hiányát mutatják, míg az abszolút értékben 1-hez közeliek erős függvényszerű 

kapcsolatot jelentenek. 

SPSS-ben az ACF függvénnyel lehet autokorreláció elemzést végezni. Ez elérhető az Analyze → 

Forecasting → Autocorrelations… menüponttal is, de a következő szintaxissal (ACF utasítás) is 

futtatható. 

 

Szokásosan a VARIABLES opcióban adjuk meg az idősort, amire szeretnénk autokorrelációt 

számítani. Itt a LAG érték az eltolást jelenti, alapértelmezetten 16-ra van beállítva. Az MXAUTO 

opcióval módosíthatjuk ennek az értékét. Mivel 600 értékünk van alap_c változóban, 599 eltolás 

lehet ezen 600 érték között. Az így kapott ACF és PACF grafikonok, vagy más néven 

korrelogramok már kevésbé áttekinthetőek a túl sok érték miatt. Ugyanakkor érdemes első körben 

a teljes idősorra megnézni ezeket a grafikonokat egy-egy elemzés során, hogy legyen egy 

impressziónk az idősor összefüggésének karakterisztikájáról (megjegyzés: LAG=600-zal is lefut). 

Utána már jellemzően csak olyan LAG értékkel jelenítik meg a korrelogramot, ahányad rendű 

ARMA (vagy ARIMA) modellt illesztenek az adatokra (ez jellemzően maximum 3). 

A korrelogramok vizsgálata ad egy elsődleges benyomást, hogy milyen ARIMA modellt érdemes 

alkalmaznunk majd az idősorunk sztochasztikus kapcsolatainak feltárására. A modellillesztés 

felismerésében támogatnak ezek. 



TÁMOP 4.2.4.A/2-11-1-2012-0001  László Anna 

72 / 33 
 

 

 



TÁMOP 4.2.4.A/2-11-1-2012-0001  László Anna 

72 / 34 
 

Azért már ezen ábrákról is leolvasható az, hogy nincs igazán olyan érték, ami nagyon túllógna a 

konfidencia intervallumot szemléltető vonalakon (konfidencia sáv), jelezve, hogy annyi másodperc 

eltolással szignifikáns a kapcsolat az időben. 

Egy 100-as LAG érték beállításával is megjeleníthetjük az ACF és PACF függvényeket egy jobb 

fókusz érdekében. 
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A parciális autokorrelációs értékek néhol lépik túl a megadott görbét, de csak igen kicsi értékekkel. 

Az autokorrelációs értékek -0,084 es 0,11 között mozognak, vagyis igen kicsik. Eszerint nem 

mutatható ki erős (értékelhető) autokorreláció (időben történő összefüggés) az alapsorban (korrigált 

értékében: alap_c). 

Alapvetően a statisztikai elemzések értelmezésekor mindig érdemes figyelni arra, hogy milyen 

szakmai kérdést is kívánunk megválaszolni éppen a statisztika eszközrendszerével. Attól, hogy 

valami szignifikáns eredményt mutat, még lehet, hogy szakmailag nem releváns a kimutatott eltérés 

(hatás, stb.). Figyeljünk mindig, hogy ne értelmezzük félre ezeket az eredményeket. Az is igaz 

mindig, hogy az elemszám növelésével ugyanazon eltérés már egy idő után szignifikáns lesz, de, ha 

szakmailag nem értelmezhető, akkor ne vegyük figyelembe. 

7.7 GÖRBEILLESZTÉS 

Azt már a korábbi idősor görbéken is láttuk, hogy az artefaktumoktól mentes korrigált alap jelben 

sűrűn váltják egymást a csúcsok és a völgyek. Talán valamiféle nagyon lassú emelkedés észlelhető 

az értékekben időben. Nézzük meg első körben egy lineáris görbe illesztését a pontjainkra. 

A következő kódrészlet tulajdonképpen egy lineáris trend és egy hibatag összegéből álló 

dekompozíciós modellt illeszt az értékeinkre. 
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Az eredményből kiolvashatók az alábbiak: 

A Model Summary tábla alapján az illesztés nem sikeres, mert az R-négyzet értéke mindössze 0.007 

(a lineáris trend szinte semmit nem magyaráz meg a jelenségből, hiszen az adatok varianciáját 

csupán 0,7%-ban magyarázza). A legtöbbször használják az R-négyzet értéket modell magyarázó 

erejének meghatározásakor, ugyanakkor itt is, mint a nemparaméteres Kolmogorov-Smirnov 

próbánál figyelembe kell vennünk, hogy független adatok esetén működik, ami idősor esetén nem 

áll fenn. Jellemzőbb az AIC (Akaike Information Criterion), vagy a BIC (Bayes Information 

Criterion) értékek alapján való döntés (több modell futtatásakor a kisebb AIC vagy BIC értékkel 

rendelkező modellt érdemes választani), ezek ugyanakkor még nincsenek minden hasonló próbához 

beépítve a statisztikai programokba. SPSS sem kezeli ezt a CURVEFIT utasításában. 

A Coefficients táblában találjuk, hogy az illesztett egyenes meredeksége/iránytangense: 7,774. 

Ezzel a hozzá tartozó t tesztstatisztika p-értéke (p=0.000) alapján a meredekség szignifikánsan 

különbözik a 0-tol, de igen kicsi ez az érték, nem nagyon értelmezhető. 

 
Az illesztett egyenesen látható az előzőleg a számokkal is alátámasztott nagyon enyhe emelkedés az 

időben. 
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A futtatás eredményeként kimentettük az illesztett lineáris modell értékeit, melyet az 

adatállományban egy FIT_1 értékkel tárol az SPSS. Ezt a Variable View nézetben átírhatjuk 

mondjuk fit_linear_alap-ra a következő ábrák szerint (előbb Data View-ban az értékek még FIT_1 

néven, majd Variable View-ban már az átírt változónév). 

 

 

A Label oszlopban bármely címke adható a változóknak. Az SPSS a modellillesztés során a fenti 

képen látható címkét generálja. 

Nézzünk meg egy négyzetes és egy köbös polinom illesztést is, bár az idősort látva nem várunk 

sokkal jobb illeszkedést. Ehhez az alábbi kódot futtassuk le a Syntax ablakban. 
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Láthatjuk, hogy szinte ugyanazt a programsort kell futtatni, csak a MODEL opcióban adunk meg 

más paramétert a négyzetes (QUADRATIC) és köbös (CUBIC) polinom illesztéshez. 

Két új változót képzünk: a két illesztett függvény szerinti értékeket. Ezeket az előbbi, lineáris 

modell mintájára hasonlóan átnevezhetjük, ahogy azt a következő kép is mutatja. 

 

Az eredményből kiolvashatjuk az R-négyzet értékeket a modell magyarázó erejéről (ismét tartsuk 

szem előtt, hogy ez független adatok esetén értelmezhető!). Mindkét érték igen kicsi (négyzetes 

esetén 0,007, köbös esetén 0,014). 

Ha szemléltetjük az előző 3 modellillesztést a már módosított változóneveket alkalmazzuk a 

TSPLOT függvény VARIABLES utasításában. 

 

Az eredmény az alábbi. 
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A 3 illesztett görbe szinte egybeesik, és egyik sem illeszkedik jól az eredeti idősorra. 

A köbös kivételével nagyon lassú monoton növekedő függvény a lineáris és a négyzetes, de igazán 

egyik illesztés sem használható. 

7.8 SZEZONÁLIS DEKOMPOZÍCIÓ, MINT DETERMINISZTIKUS 

MATEMATIKAI MODELL 

Az eddigi eredmények alapján (az eredeti időfüggvény görbéjét, vagy az autokorrelációs függvény 

értékeit nézve) nem várunk szezonalitást az alap idősorban, de azért elvégezhetünk egy vizsgálatot, 

hogy van-e mégis valamiféle periodicitás időben a jelben. 

Erre dekompozíciós (más néven determinisztikus) modellt alkalmazunk, melyekkel általánosan 

három determinisztikus összetevő: a trendfüggvény, a szezonális ingadozásokat leíró függvény és a 

ciklusfüggvény adott súlyú összegét vagy szorzatát képezhetjük. Ha összegezzük ezeket a 

determinisztikus komponenseket, akkor additív modellről beszélünk, ha szorozzuk őket, akkor 

multiplikatívnak nevezzük a modellt. A három komponens mellett még számolnunk kell az 

úgynevezett hibataggal, mely eloszlását vizsgálnunk kell a modellillesztést követően. A hibatag 

egymással korrelálatlan, azonos eloszlású, nulla várható értékű, kis szórású véletlen változók 
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sorozata, mely, ha normális eloszlást követ, akkor fehérzajnak hívjuk. Amennyiben a maradéksor 

fehérzaj, az adott modell jól illeszkedik az idősorunkra, minden lényeges információt már 

megmagyaráz (13). 

A dekompozíciós modellek elég egyszerű modellek. Bár nincs előfeltételük (mint az ARIMA 

modelleknek a stacionaritás), mégis a trendfüggvény képzésekor a mozgóátlagolás miatt 

adatvesztéssel jár. Mindenképpen azt feltételezi, hogy az adataink meghatározott komponensekből 

állnak, és a véletlen szerepét figyelmen kívül hagyja. 

Az előzőek alapján a szezonalitást keressük az idősorban szezonális dekompozíciós modell 

futtatásával. 

Ehhez először kell egy dátum változót képezni, ami jelen esetben a másodperceket fogja 

tartalmazni. Az SPSS-ben ez megtehető menüsorból is a Data → Define Dates… menüponttal. 

Amennyiben szintaxissal futtatjuk a következő kódrészlet első sorát írjuk be a Syntax ablakba (a 

többit az SPSS generálja a futtatással). 

 

Ennek eredményeképp létrejön három új változó az adatállományban: MINUTE_, SECOND_ és 

DATE_, mely szerint a percen belül már a másodpercek periodicitással jelennek meg, így képezve a 

DATE_ változót. 

Az adatállományban az alábbi változók jöttek létre. 
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A következőkben nézzük meg a dekompozíciós modellillesztéseket. 

7.8.1 Multiplikatív modell 

A multiplikatív dekompozíciót, ha menüből kívánjuk elérni a szoftverben, akkor az Analyze → 

Forecasting → Seasonal Decomposition… menüpontot válasszuk. Egyébként lefuttathatjuk a 

következő szintaxist is. 

 

Ahogy a szürke kommentekből is látszik, ezzel négy új változó jön létre az adatállományban, 

melyet a következő képen láthatunk is a Data View ablakban.  
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Ezeket érdemes átnevezni az adott modell szerint, hogy további futtatások eredményei később is 

beazonosíthatóak legyenek. Így például adhatjuk nekik a következő változóneveket a Variable View 

ablakban. 

 

Ezen változók jelentése a következő: 

ERR_1_mul: ez a hibatag / maradéktag (a generált név az error szóra utal) 

SAS_1_mul: ebben a változóban tárolódik a szezonális hatástól megfosztott idősor. Ez a korrigált 

alap jel és a szezonális tag hányadosa: alap_c / SAF_1_mul (a „seasonally adjusted” kifejezésből 

ered az elnevezés) 

SAF_1_mul: ez a szezonális tag, ami a „seasonal factor” elnevezésből eredeztethető 
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STC_1_mul: ezen változó tartalmazza a trend hatást. Neve a „trend-cycle” kifejezésből ered. A 

szezonális hatástól megfosztott idősor simított változata, vagyis a SAS_1_mul változóból simítással 

készül. 

Ha ezeket az eredeti (korrigált alap) idősorral együtt megjelenítjük akár menüsorból (Analyze → 

Forecasting → Sequence Charts…), akár a következő kódrészlet lefuttatásával, akkor láthatjuk a 

különálló hatásokat. 

 

A kapott eredmény a következő. 

 
Bár eléggé átfedik egymást a görbék, de annyi látható, hogy a hibatag és a szezonális komponens 

együtt mozog, valamint külön, de hasonló nagyságrendben az eredeti alap_c függvény, a 

trendfüggvény és a szezonális komponenstől megfosztott idősor. Ezt így is várjuk. 

Külön-külön megvizsgálva az egyes komponenseket, hogy jobban lássuk és értsük a folyamatot, 

nézzük meg először csak a szezonális összetevőt. 
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A fenti szintaxis futtatásának eredménye a következő diagram. 

 
Az ábráról leolvasható, hogy minden perc 10-edik másodperce környékén van egy csúcs, ami eltér 

az 1-től 1,75 körüli értékkel. Ez egy periodicitást mutat. Látható továbbá, hogy a szezonális 

komponens a minimum értékeket az adott perc 30-adik másodperce környékén veszi föl, míg a 

maximumot az előbb említett 10 sec. körül. 

A multiplikatív modellben az 1 faktor felel meg a szezonalitás hiányának. A szezonális komponens 

minimum értéke megközelítőleg 0,62, míg maximuma 1,75 körül van. 

Amennyiben csak a trendkomponenst nézzük, az alábbi kódsort lefuttathatjuk. 
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A kapott eredmény diagram jól mutatja a trendfüggvény korrigált alap jelre való illeszkedését. 

 
A trendfüggvényben nem igazan látszódik hosszú távú ciklus, hullámzás, leginkább random 

váltakozik a görbe. 

A maradéksort is nézzük meg külön. Itt ellenőriznünk kell a normalitást is. Ehhez először a 

következő programkóddal szemléltessük a hibatagot. 

 

A futtatás eredménye az alábbi. 
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Láthatóan az 1 körül oszcillál a maradéksor, és semmilyen felismerhető mintázatot nem mutat, 

stacionáriusnak tűnik. 

A normális eloszlás ellenőrzésére rajzoljunk ki egy P-P diagramot, majd hisztogramot és végül egy 

Kolmogorov-Smirnov próbát is számoljunk az alábbi szintaxis szerint. 
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Az eredmények a következők. 
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A P-P diagramon az átlótól egy szakaszon eltérnek a pontok, egy másfajta (mint lineáris) 

szabályszerűséget mutatnak. A hisztogram enyhén jobbra ferde eloszlást mutat két csúccsal. A 

Kolmogorov-Smirnov próba 0,966 átlagú, 0,43 szórású eloszlást mutat, mely 5%-os szinten 

szignifikánsak eltér a normális eloszlástól (p=0,011). Itt is megjegyezném, hogy független adatok 

esetén értelmezett, ugyanakkor gazdasági elemzésekben és az SPSS könyvben is ezt alkalmazzák, 

ezért mi is lefuttatjuk, de fenntartásokkal kezeljük. 

Ezek alapján tehát az 1 várható értékű normális eloszlástól szignifikánsan eltér a hibatag, azaz, 

mint idősor fehérzajnak nem tekinthető. Eszerint az idősor multiplikatív dekompozíciója nem 

mondható sikeresnek. 

Ellenőrzésként hozzuk létre a multiplikatív modell változóját az 

alap_c = stc_1_mul * saf_1_mul * err_1_mul 

képlettel a modellünkből visszaszámolva. 

A következő kódsorral létrehozzuk előbb ezt a változót (COMPUTE), majd együtt az eredeti alap_c 

idősorral, majd külön-külön is kirajzoljuk a TSPLOT utasításokkal. 
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A COMPUTE hatására az adatállományban létrejött a seasonal_decomp_multipl_model elnevezésű 

változó, mely a modell illesztett értékeit tartalmazza. 

Azon az ábrán, ahol az alap_c és a seasonal_decomp_multipl_model idősorok is szerepelnek, ez 

utóbbi meglehetősen elfedi az alapot, ezért néztük meg külön-külön is. 
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Külön a korrigált alap idősor. 

 
Majd a szezonális dekompozíciós modellillesztés idősora. 

 
A két ábrát összehasonlítva, értékeiket figyelembe véve elmondható, hogy a két görbe gyakorlati 

szempontból nem egyezik meg. A szezonális dekompozíciós görbe nagyobb értékeket mutat. 
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7.8.2 Additív modell 

Az additív szezonális dekompozíciós modellt az előző mintájára végezhetjük el. Ugyancsak az 

Analyze → Forecasting → Seasonal Decomposition… menüből érhető el, vagy a következő 

parancssorral. 

 

A kódban is látszik, hogy a MODEL paraméterben kell most az ADDITIVE kulcsszót megadni a 

korábbi MULTIPLICATIVE helyett. Ezzel is négy új modellfüggvény változó jött létre az 

adatállományban, melyeket érdemes az előző mintájára elnevezni (most az additív modell miatt 

_add véggel): 

 

ERR_1_add: hibatag/maradéktag 

SAS_1_add: a szezonális hatástól megfosztott idősor (alap_c - SAF_1_add) 

SAF_1_add: szezonális tag 

STC_1_add: trendfüggvény 

Az eredeti korrigált alap idősorral együtt megjelenítve az új változókat a következő szintaxis 

lefuttatásával kaphatjuk meg a grafikont. 
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Itt is kirajzolódik, amit a multiplikatív modell esetén láthattunk, hogy a hibatag és a szezonális 

komponens kb. egy skálán mozog, míg az alap_c idősorral együtt megy a szezonális komponenstől 

megfosztott összetevő idősora, és az ebből simítással nyert trendfüggvény. 

Ha külön-külön megnézzük, előbb a szezonális komponenst, ismét TSPLOT utasításokat kell 

felparamétereznünk. 

 



TÁMOP 4.2.4.A/2-11-1-2012-0001  László Anna 

72 / 53 
 

 
Látható, hogy a szezonális komponens a minimum értékeket az adott perc 30-adik másodperce 

környékén veszi föl (min. ~ -3), míg a maximumot 10 sec. körül (max. ~ 6), ugyanúgy, mint a 

multiplikatív modellben, csak itt a 0-tól való eltérést nézzük, és más a skála. 

Az additív modellben a 0 faktor felel meg a szezonalitás hiányának. Eszerint itt is megfigyelhető 

egyfajta periodicitás. 

Ha külön csak a trendkomponenst nézzük a korrigált alapra vetítve, láthatjuk az illeszkedést. 

 

A fenti kódsor lefuttatásával kapjuk a következő ábrát. 
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A trendfüggvényben nem igazán látszódik hosszú távú ciklus, hullámzás, vagy egyenletesen 

növekedő tendencia (talán egy nagyon enyhe emelkedés csak), leginkább random váltakozik a 

görbe. 

Ellenőrizzük, hogy a maradéksor fehérzaj folyamat-e. Ehhez előbb jelenítsük meg (TSPLOT), majd 

nézzük meg az előzőek mintájára a P-P diagramot (PPLOT) és a Kolmogorov-Smirnov próba 

(NPTESTS) eredményét. Ezekhez a következő szintaxisokat futtassuk le az SPSS-ben. 
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A nemparaméteres próbához a normális eloszlástól való eltérés vizsgálatához pedig: 

 

A kapott eredmények a következők lettek. 
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Már az idősor diagramon is látható, hogy az adatok random szóródnak a nulla körül. 

A P-P diagramon a pontok kb. követik az átlót, de egy kis eltérő szabályosság is megfigyelhető (egy 

nagyon enyhe hullám - más függvényszerű kapcsolat, nem random szóródás). 

A Kolmogorov-Smirnov próba 0,112-es p-értéket adott, miszerint a maradéktag nem különbözik 

szignifikánsan (5%-os szinten) a fehérzajtól (véletlenszerű változás a sequence plot alapján, 

normális eloszlás a PPLOT es NPTESTS alapján). Ezért az idősor additív dekompozíciója 

sikeresnek tekinthető, bar sokat nem árul el. (Azért itt is figyeljünk arra, hogy a normalitás teszt 

független adatokra működik leginkább.) 

Ellenőrizhetjük most is az additív modellünket. Ehhez képezzük a következő rövid szintaxis 

lefuttatásával a seasonal_decomp_add_model változót. 

 

Megjelenítve az illesztett modellt és az eredeti korrigált alap idősort az alábbi kódot futtathatjuk, 

amivel egy diagramon, de külön-külön is kirajzoljuk a grafikonokat. 
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Az eredményt a következő három ábra mutatja, melyeken jól látható, hogy azért az additív modell 

is jócskán elfedi a korrigált alap idősor értékeit, vagyis az illesztés nem használható igazán, hiába 

találtuk fehérzaj folyamatnak a maradéktagot. Eszerint ennél többet viszont ilyen idősor elemzéssel 

nehéz kinyerni az adatokból. 

 
A korrigált alap idősor görbéje: 
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Az illesztett additív szezonális dekompozíciós modell. 

 
A kapott grafikonokon jól látható, hogy a két görbe gyakorlati szempontból nem egyezik meg. A 

szezonális dekompozíciós görbe nagyobb értékeket mutat a multiplikatívhoz hasonlóan, mint a 

korrigált alap idősor. 
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7.9 EXPONENCIÁLIS SIMÍTÁS 

A simító eljárások a determinisztikus modelleknél jobban figyelembe veszik az idősor véletlen 

jellegét, belső összefüggéseit. A véletlen hatást simítással (kiátlagolással) próbálják csökkenteni. Az 

exponenciális szűrés egyike ezen simító eljárásoknak, mely során determinisztikus modellből 

kiindulva lépésenként előrejelzünk (csak egy lépéssel becsülünk előre), majd a keletkező hibataggal 

negatív visszacsatolással korrigálunk. A módszer neve onnan ered, hogy az idősor t-edik 

időpillanatban vett elemét az őt megelőző (múltbeli) elemek exponenciálisan csökkenő súlyokkal 

vett lineáris kombinációjával becsüljük (13). 

Az exponenciális simítás módszerét először 1956-ban alkalmazta Robert Goodell Brown (14). 

Az IBM SPSS szoftverben természetesen az előzőek mintájára ezt az elemzést is el lehet érni 

menüből. Ehhez az Analyze → Forecasting → Create Models… menüpontot válasszuk, ahol 

Method-nak állítsuk be az Exponential Smoothing opciót. Ha parancssorból szeretnénk futtatni, 

akkor a következő szintaxist használhatjuk föl. 

 

Az utolsó sorban az EXSMOOTH opcióban láthatjuk, hogy a Simple típusú modellt futtattuk, mely 

esetben semmilyen trendet, vagy szezonális hatást nem tételezünk fel az idősorban. 

Az eredményből jól látható, hogy például a modell magyarázó erejét leíró R-négyzet érték 0-hoz 

közeli (lásd Model Fit vagy Model Statistics táblákban az R-squared értékét), ami azt mutatja, hogy 

az illesztés korrelálatlan az idősortól. Ez tehát megint csak egy rosszul illeszkedő modell az 

eredeti (korrigált) idősorra. (Ugyanakkor itt is figyelnünk kell arra, hogy az R-négyzet független 

adatok esetén használható igazán a modell magyarázó erejének leírására, itt viszont idősorról 

beszélünk, mely összetartozó adatokat tartalmaz!) 

A Residual ACF és Residual PACF táblákból valamint a generált diagramokból is látható, hogy a 

maradéktag (hibatag, reziduál értékek idősora) autokorrelálatlan idősor, egészen a 24-edik tagig 

visszamenve (LAG értéke 24 az AUXILIARY utasítás MAXACFLAGS opciójában), hiszen 

alacsonyak az autokorrelációs és parciális autokorrelációs értékek (a korrelogramokon a 
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konfidencia sávot nem is lépik túl). Ezt alátámasztja a Model Statistics táblában található Ljung-

Box tesztstatisztika p-értéke (p=0,818), ami ugyancsak jelzi, hogy a maradéktag fehérzajnak 

minősíthető. Ettől függetlenül maga a függvény nem modellezi az idősorunkat. 

A Model Statistics tábla eredményét, majd a hibatag autokorrelációs és parciáis autokorrelációs 

ábráit láthatjuk a következő képeken, végül magát az illesztett exponenciális szűrési modell 

eredményét idősor grafikonon ábrázolva az eredeti korrigált alap (alap_c) idősorral együtt 

szemléltetve. 

Model Statistics 

Model Number of 

Predictors 

Model Fit statistics Ljung-Box Q(18) Number of 

Outliers Stationary R-

squared 

R-squared Statistics DF Sig. 

alap_c-Model_1 0 ,512 -,001 11,701 17 ,818 0 

 
Az exponenciálisan szűrt idősort láthatjuk (kék) a következő ábrán a megfigyelt értékekre (piros) 

vetítve 95%-os konfidencia intervallummal együtt. 
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Ha megnézzük a Simple módszer helyett a Holt-féle lineáris trend illesztéssel kapott exponenciális 

simító eljárást, akkor ahhoz a következő szintaxist kell lefuttatnunk. 

 

Itt az utolsó sorban az EXSMOOTH utasítás típusaként a HOLT kulcsszót adhatjuk meg. (A Holt és 

Simple módszerek hasonló eredményt adnak, a Holt módszer több helyen használt.) 

A Holt típusú exponenciális simító modell R-négyzet értéke is igen alacsony (-0,043), ami 

hasonlóan az előző Simple modellhez azt jelzi, hogy az illesztés itt is korrelálatlan az idősortól. A 

Ljung-Box próba p-értéke itt már 0,097, ami bár 5 %-os szinten nem szignifikáns, de 10%-os α 

mellett már igen, vagyis 10%-os szinten már szignifikánsan eltér a maradéktag a fehérzajtól. Így 

megállapíthatjuk, hogy ez sem jó modell az adataink leírására, bár nem is nagyon vártuk az eddigi 

eredmények alapján (előző Simple modell, vagy a sima lineáris trend illesztés). 

A kapott eredmények most az alábbiak. 
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Model Statistics 

Model Number of 

Predictors 

Model Fit statistics Ljung-Box Q(18) Number of 

Outliers Stationary 

R-squared 

R-squared Statistics DF Sig. 

alap_c-Model_1 0 ,832 -,043 23,679 16 ,097 0 
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Az adatállományban lementésre kerültek a SAVE utasítás hatására a megfelelő illesztett 

függvények és a második esetben, a Holt-féle lineáris trendnél a reziduálok is. Ezeknek a változó 

neveit és címkéit érdemes beszédesebben elnevezni mondjuk az alábbi kép szerint a Variable View 

ablakban. 

 

7.10 ARIMA MODELLILLESZTÉS 

A legárnyaltabb, legösszetettebb idősoros elemzés a Box és Jenkins által kidolgozott ún. ARIMA 

modellekkel lehetséges. A szóösszetétel az AR, I és MA részekre bontható, melyek az 

autoregresszív, integrált és mozgóátlag folyamatok elnevezéseire utalnak. Ezek a modellek az 

idősor adatai között meglévő belső sztochasztikus koherenciát feltételeznek, melyek tartósan jelen 

vannak az idősorban, ami által pontos előrejelzések várhatók a modellekben. 

Az autoregresszív folyamatokban egy adott t időpontbeli érték az őt megelőző (múltbeli) értékek 

lineáris kombinációjaként (súlyozott összegeként) és egy korrelálatlan hibatag összegeként áll elő. 

A mozgóátlagolás során egy végtelen hosszú fehérzaj folyamat egyfajta mozgóátlaga és egy 

korrelálatlan hibatag összegeként modellezzük az idősort. 

Beszélhetünk ún. ARMA modellekről is, melyekben az idősor egy autoregresszív, egy mozgóátlag 

és egy korrelálatlan hibatag összegeként definiálható. Az integrált ARIMA modellek esetén az 

idősor deriváltsora (szomszédos elemek különbsége) lesz ARMA típusú (13). 

Az IBM SPSS-ben ugyancsak az Analyze → Forecasting → Create Models… menüpontban érhető 

el az ARIMA modellillesztés is. Itt választhatjuk az Expert Modeler opciót is, amivel a 19-es 

verziótól kezdve már lehetőségünk van automatikus modellillesztésre, vagyis a szoftver megkeresi, 

hogy melyik illeszkedik a legjobban. Ehhez az EXPERTMODELER utasítást használhatjuk, ahogy 

az alábbi szintaxisban is olvasható. 
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Az eredmény, vagyis a legjobban illeszkedő ARIMA vagy exponenciális simító modell egy kb. 

konstans modell lett (8,53-as értékkel mindenhol, egy kivétellel, ami 4:02-kor 48), semmilyen 

transzformációt nem végzett. Eszerint nem nagyon lehet mit kihozni így ebből az idősorból. Az R-

squared érték is 0,084, ami azt jelenti, hogy mindössze 8,4%-ban magyarázza ez a konstans modell 

az idősor teljes varianciáját (független adatokat feltételezve!). 

Az illesztett függvény változója létrejött a fenti szintaxis lefuttatásával az adatállományban, amit 

érdemes a korábban látottak mintájára átnevezni a megfelelő modellre utalva. 

 

Címkének adhatjuk a Variable View nézetben például a „Predicted value from alap_c - Expert 

Modeler best fit: Constant model” leírást. 
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Az Output ablakban generált eredményekből a következők jól összegzik a lényeget. 

Model Statistics 

Model Number of 

Predictors 

Model Fit statistics Ljung-Box Q(18) Number of 

Outliers Stationary R-

squared 

R-squared Statistics DF Sig. 

alap_c-Model_1 0 ,084 ,084 13,505 18 ,761 1 

A Ljung-Box próba alapján a maradéksor fehérzajnak tekinthető, vagyis a modellünk már minden 

lényeges információt megmagyaráz. 

ARIMA Model Parameters 

 Estimate SE t Sig. 

alap_c-Model_1 alap_c No Transformation Constant 8,529 ,217 39,254 ,000 

Az ARIMA Model Parameters táblában látható, hogy a transzformáció nélküli modell lett 

szignifikánsan illeszkedő az alap_c idősorunkra. Ez tulajdonképpen az ARIMA(0,0,0) modell. 

Outliers 

 Estimate SE t Sig. 

alap_c-Model_1    4:02 Additive 39,471 5,322 7,416 ,000 

Az Outliers táblázat mutatja, hogy az idősorban egy elem van (4:02-kor), ami kiugró, vagyis 

jelentősen eltér ebben az időpontban a modellből számított érték az eredeti mért értéktől. Ez az, 

amit korábban már tapasztaltunk a generált változó vizsgálata során az adatállományban. 

A Residual ACF és PACF grafikonok alátámasztják a Ljung-Box próba eredményét. 
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Az illesztett modell és az eredeti korrigált alap idősor grafikonját láthatjuk végül. 
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7.11 SPEKTRÁL ELEMZÉS 

A sztochasztikus idősor elemzésnek két ágát különíthetjük el: Az egyik az eddigiekben is taglalt 

időtartományon alapuló vizsgálat, amely az idősor dinamikájára, az egymást követő 

megfigyelésekre épít sztochasztikus idősori modellek segítségével (ARIMA modellek). A másik 

terület a frekvenciatartományban történő elemzés, amely a ciklikus komponensek súlyának 

összességét vizsgálja a spektrálanalízis módszerével. 

A ciklikus folyamatokban a periódus hossza legtöbbször ismert és a szezonális komponensben 

figyelembe van véve. Előfordulhatnak azonban a természeti folyamatokban is rejtett ciklusok az 

idősorban, melyek kimutatására alkalmas egyik statisztikai módszer a periodogram. 

A periodogram matematikai oldalról közelítve a gyors Fourier transzformáción alapszik (FFT: 

Fast Fourier Transform), mellyel az időtartományról áttérünk frekvencia tartományra szinusz és 

koszinusz függvények kombinációjaként. 

A periodogram megadható periódus vagy frekvencia függvényében is (ezek egymás reciprokai: 

f=1/T). Amikor periódus szerint adjuk meg, értéke annál a periódusnál nagy, amely szerint az 

idősorban a ciklikusság tapasztalható. Frekvencia alapon történő ábrázolás esetén, ha valamely 

frekvenciánál kiugró értéket észlelünk, létezik a folyamatnak spektrális összetevője. Akkor 

nevezzük inkább periodogramnak, ha periódus függvényében ábrázoljuk. A frekvenciák 

függvényében történő ábrázolást inkább spektrogramnak hívjuk. A periodogram simításával 

kapjuk a spektrogramot: súlyozással spektrális ablakot (ablakfüggvényt) használnak. Különféle 

ablakfüggvények léteznek, mint a Hamming-Tukey, a Parzen vagy például a Bartlett módszer. Ez 

utóbbi módszer gyakran alkalmazott a variancia probléma csökkentésére (adott frekvencián a 

variancia emelkedő esetszám ellenére sem csökken). A módszer lényege abban rejlik, hogy az 

eredetileg n elemű idősort részekre osztjuk, melyekben külön-külön diszkrét Fourier 

transzformációt végzünk, majd a négyzetüket átlagoljuk (13, 15). 

 

Ha lenne a szezonális dekompozíció eredményeként kapott trendkomponensben valamiféle 

hullámzás, hosszú távú ciklus, érdemes lenne periodicitás elemzést végezni az eredeti korrigált 

adatsoron. 

Bár most ilyet nem tapasztaltunk, nézzük meg azért a spektrum elemzés egyik módszerének 

gyakorlása végett. 

IBM SPSS-ben az Analyze → Forecasting → Spectral Analysis… menüben érhető el a spektrum 

elemzés. 

Ha szintaxisból szeretnénk futtatni, az alábbi kódsort használhatjuk. 
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A Bartlett-ablak került felhasználásra, mint az látható a WINDOW utasításban. 

Az eredmény periodogram a következő. 

 
A kapott periodogramon látható, hogy sehol nem vesz fel kimagasló maximum értéket, vagyis nem 

tapasztalható ismétlődés ilyen másodperces adatokat figyelembe véve. Random szóródnak az 

értékek. 

 

Frekvencia alapon vizsgálódva az alábbiképpen írhatjuk át a szintaxisunk (csak a PLOT utasítás 

paraméterei változnak). 
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A spectral density (spektrális sűrűségfüggvény vagy más néven spektrum) függvény a 

periodogram simított változata. Ez már mentes az esetleges ingadozásoktól. 

A periodogram itt a következőképpen néz ki már a frekvenciatartományon vizsgálódva. 

 
Az eredmények között lekértük a Spectral Density diagramot, azaz a spektrumot is. 
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Itt is látható, hogy random szóródnak az értékek (random váltják egymást a csúcsok és völgyek), 

nem érzékelhető periodicitás ebből. 

Ha a parciális korrelogram alapján már igazoltunk volna valamilyen periodicitást, akkor azt 

ellenőrizhetnénk itt is a megfelelő Fourier-frekvencia kiszámításával. Ha pl. 20 másodpercenként 

lenne valami a jelben, akkor az 1/20 értéknél kellene kb. lennie az első nagy csúcsnak a spektrum 

függvényben. Ezt követően szabályosan ismétlődhetne (2/20, 3/20, stb. értékeknél újabb 

csúcsokkal). Ha így több csúcs lenne, akkor azt mutatná, hogy a jel nem tisztán szinuszoid idősor 

(mert a tisztán szinuszoid idősorok spektrumában van egyetlen csúcs csupán). 

De nincs ilyen csúcsunk sehol, vagyis újabb bizonyíték, hogy nincs szezonalitás az alap korrigált 

adatsorunkban. 
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Végtelen hálás vagyok Lang Zsoltnak, akihez szakmai kérdésekkel tudtam fordulni az adatelemzés 

és kapott eredmények értelmezése kapcsán, melyekhez nagyon hasznos tanácsokat adott. 
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